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INTRODUCTION
What is Finite Element Analysis?

Finite Element Analysis, commonly called FEA, is a method of numerical analysis. FEA is used for solving problems in many engineering disciplines such as machine design, acoustics, electromagnetism, soil mechanics, fluid dynamics, and many others. In mathematical terms, FEA is a numerical technique used for solving field problems described by a set of partial differential equations.

In mechanical engineering, FEA is widely used for solving structural, vibration, and thermal problems. However, FEA is not the only available tool of numerical analysis. Other numerical methods include the Finite Difference Method, the Boundary Element Method, and the Finite Volumes Method to mention just a few. However, due to its versatility and high numerical efficiency, FEA has come to dominate the engineering analysis software market, while other methods have been relegated to niche applications. You can use FEA to analyze any shape; FEA works with different levels of geometry idealization and provides results with the desired accuracy. When implemented into modern commercial software, both FEA theory and numerical problem formulation become completely transparent to users.

Who should use Finite Element Analysis?

As a powerful tool for engineering analysis, FEA is used to solve problems ranging from very simple to very complex. Design engineers use FEA during the product development process to analyze the design-in-progress. Time constraints and limited availability of product data call for many simplifications of the analysis models. At the other end of scale, specialized

analysts implement FEA to solve very advanced problems, such as vehicle crash dynamics, hydro forming, or air bag deployment. This book focuses on how design engineers use FEA as a design tool. Therefore, we first need to explain what exactly distinguishes FEA performed by design engineers from "regular" FEA. We will then highlight the most essential FEA characteristics for design engineers as opposed to those for analysts.

FEA for Design Engineers: another design tool

For design engineers, FEA is one of many design tools among CAD, Prototypes, spreadsheets, catalogs, data bases, hand calculations, text books,

etc. that are all used in the design process.

FEA for Design Engineers: based on CAD models

Modern design is conducted using CAD tools, so a CAD model is the starting point for analysis. Since CAD models are used for describing geometric information for FEA, it is essential to understand how to design in CAD in order to produce reliable FEA results, and how a CAD model is different from FEA model. This will be discussed in later chapters.

FEA for Design Engineers: concurrent with the design process

Since FEA is a design tool, it should be used concurrently with the design process. It should keep up with, or better yet, drive the design process. Analysis iterations must be performed fast, and since these results are used to make design decisions, the results must be reliable even when limited input is available.

Limitations of FEA for Design Engineers

As you can see, FEA used in the design environment must meet high requirements. An obvious question arises: would it be better to have dedicated specialist perform FEA and let design engineers do what they do best - design new products? The answer depends on the size of the business, type of products, company organization and culture, and many other tangible and intangible factors. A general consensus is that design engineers should handle relatively simple types of analysis, but do it quickly and of course reliably. Analyses that are very complex and time consuming cannot be executed concurrently with the design process, and are usually better handled either by a dedicated analyst or contracted out to specialized consultants.

Objectives of FEA for Design Engineers

The ultimate objective of using the FEA as a design tool is to change the design process from repetitive cycles of "design, prototype, test" into streamlined process where prototypes are not used as design tools and are only needed for final design verification. With the use of FEA, design iterations are moved from the physical space of prototyping and testing into the virtual space of computer simulations (figure 1-1).
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Figure 1-1: Traditional and. FEA- driven product development

Traditional product development needs prototypes to support design in progress. The process in FEA-driven product development uses numerical models, rather than physical prototypes to drive development. In an FEA driven product, the prototype is no longer a part of the iterative design loop.

What is Solid Works Simulation?

Solid Works Simulation is a commercial implementation of FEA, capable of solving problems commonly found in design engineering, such as the analysis of deformations, stresses, natural frequencies, heat flow, etc. Solid Works Simulation addresses the needs of design engineers. It belongs to the family of engineering analysis software products developed by the Structural Research & Analysis Corporation (SRAC). SRAC was established in 1982 and since its inception has contributed to innovations that have had a significant impact on the evolution of FEA. In 1995 SRAC partnered with the Solid Works Corporation and created Solid Works Simulation, one of the first Solid Works Gold Products, which became the top-selling analysis solution for Solid Works Corporation. The commercial success of Solid Works Simulation integrated with Solid Works CAD software resulted in the acquisition of SRAC in 2001 by Dassault Systems, parent of Solid Works Corporation. In 2003, SRA Corporations merged with Solid Works Corporation. Solid Works Simulation is tightly integrated with Solid Works CAD software and uses Solid Works for creating and editing model geometry. Solid Works is a solid, parametric, feature-driven CAD system. As opposed to many other CAD systems that were originally developed in a UNIX environment and only later ported to Windows, Solid Works CAD was developed specifically for the Windows Operating System from the very beginning. In summary, although the history of the family of Solid Works FEA products dates back to 1982, Solid Works Simulation has been specifically developed for Windows and takes full advantage this of deep integration between Solid Works and Windows, representing the state-of-the-art in the engineering analysis software.

Fundamental steps in an FEA project

The starting point for any Solid Works Simulation project is a Solid Works model, which can be one part or an assembly. At this stage, material properties, loads and restraints are defined. Next, as is always the case with using any FEA based analysis tool, we split the geometry into relatively small and simply shaped entities, called finite elements. The elements are called "finite" to emphasize the fact that they are not infinitesimally small, but only reasonably small in comparison to the overall model size. Creating finite elements is commonly called meshing. When working with finite elements, the Solid Works Simulation solver approximates the solution being sought (for example, deformations or stresses) by assembling the solutions for individual elements.

From the perspective of FEA software, each application of FEA requires three steps:

· Preprocessing of the FEA model, which involves defining the model and then splitting it into finite elements

· Solution for computing wanted results

· Post-processing for results analysis

We will follow the above three steps every time we use Solid Works Simulation.

From the perspective of FEA methodology, we can list the following FEA steps:

· Building the mathematical model

· Building the finite element model

· Solving the finite element model

· Analyzing the results

The following subsections discuss these four steps

Building the mathematical model

The starting point to analysis with Solid Works Simulation is a Solid Works model. Geometry of the model needs to be meshable into a correct and reasonably small element mesh. This requirement of meshability has very important implications. We need to ensure that the CAD geometry will indeed mesh and that the produced mesh will provide the correct solution of the data of interest, such as displacements, stresses, temperature distribution, etc. This necessity often requires modifications to the CAD geometry, which can take the form of

defeaturing, idealization and/or clean-up, described below:
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It is important to mention that we do not always simplify the CAD model with the sole objective of making it meshable. Often, we must simplify a model even though it would mesh, correctly "as is", but the resulting mesh would be too large and consequently, the analysis would take too much time. Geometry modifications allow for a simpler mesh and shorter computing times. Also, geometry preparation may not be required at all; successful meshing depends as much on the quality of geometry submitted for meshing as it does on the

sophistication of the meshing tools implemented in the FEA software.

Having prepared a meshable, but not yet meshed geometry we now define material properties. (these can also be imported from a Solid Works model), loads and restraints, and provide information on the type of analysis that we wish to perform. This procedure completes the creation of the mathematical model (figure 1-2). Notice that the process of creating the mathematical model is not FEA-specific. FEA has not yet entered the picture.
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Figure 1-2: Building the mathematical model

The process of creating a mathematical model consists of the modification o CAD geometry (here removing external fillets), definition of loads, restraint material properties, and definition of the type of analysis (e.g., static) that we wish to perform.

Building the finite element model

The mathematical model now needs to be split into finite elements through a process of discretization, more commonly known as meshing (figure 1-3).Loads and restraints are also discretized and once the model has been meshed the discretized loads and restraints are applied to the nodes of the finite element mesh.
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Figure 1-3: Building the finite element model

The mathematical model is discretized into a finite element model. This completes the pre-processing phase. The FEA model is then solved with one of the numerical solvers available in Solid Works Simulation

Solving the finite element model

Having created the finite element model, we now use a solver provided in Solid Works Simulation to produce the desired data of interest (figure 1-3).

Analyzing the results

Often the most difficult step of FEA is analyzing the results. Proper interpretation of results requires that we understand all simplifications (and errors they introduce) in the first three steps: defining the mathematical model, meshing its geometry, and solving.

Errors in FEA

The process illustrated in figures 1-2 and 1-3 introduces unavoidable errors. Formulation of a mathematical model introduces modeling errors (also called idealization errors), discretization of the mathematical model introduces discretization errors, and solving introduces numerical errors. Of these three types of errors, only discretization errors are specific to FEA. Modeling errors affecting the mathematical model are introduced before FEA is utilized and can only be controlled by using correct modeling techniques. Solution errors caused by the accumulation of round-off errors are difficult to control, but are usually very low.

A closer look at finite elements

Meshing splits continuous mathematical models into finite elements. The type of elements created by this process depends on the type of geometry meshed, the type of analysis, and sometimes on our own preferences. Solid Works Simulation offers two types of elements: tetrahedral solid elements (for meshing solid geometry) and shell elements (for meshing surface geometry).Before proceeding we need to clarify an important terminology issue. In CAD terminology "solid" denotes the type of geometry: solid geometry (as opposed to surface or wire frame geometry), in FEA terminology it denotes the type of element.

Solid elements

The type of geometry that is most often used for analysis with Solid Works Simulation is solid CAD geometry. Meshing of this geometry is accomplished with tetrahedral solid elements, commonly called "tets" in FEA jargon. The tetrahedral solid elements in Solid Works Simulation can either be first order elements (draft quality), or second order elements (high quality). The user decides whether to use draft quality or high quality elements for meshing. However, as we will soon prove, only high quality elements should be used for an analysis of any importance. The difference between first and second order tetrahedral elements is illustrated in figure 1-4.
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Figure 1 -4: Differences between first and second order tetrahedral elements

First and the second order tetrahedral elements are shown before and after deformation. Note that the deformed faces of the second order element may assume curvilinear shape while deformed faces of the first order element must remain fiat.

First order tetrahedral elements have four nodes, straight edges, and flat faces. These edges and faces remain straight and flat after the element has experienced deformation under the applied load. First order tetrahedral elements model the linear field of displacement inside their volume, on faces, and along edges. The linear (or first order) displacement field gives these elements their name: first order elements. If you recall from the Mechanics of Materials, strain is the first derivative of displacement. Therefore, strain and consequently stress, are both constant in first order tetrahedral elements. This situation imposes a very severe limitation on the capability of a mesh constructed with first order elements to model stress distribution of any real complexity. To make matters worse, straight edges and flat faces cannot map properly to curvilinear geometry, as illustrated in figure 1-5.
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Figure 1-5: Failure of straight edges and flat faces to map to curvilinear geometry

A detail of a mesh created with first order tetrahedral elements. Notice the imprecise element mapping to the hole; flat faces approximate the face of the cylindrical hole.

Second order tetrahedral elements have ten nodes and model the second order (parabolic) displacement field and first order (linear) stress field in their volume, along laces, and edges. The edges and faces of second order tetrahedral elements before and after deformation can be curvilinear. Therefore, these elements can map precisely to curved surfaces, as illustrated

in figure 1-6. Even though these elements are more computationally demanding than first order elements, second order tetrahedral elements are used for the vast majority of analyses with Solid Works Simulation.
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Figure 1-6: Mapping curved surfaces

A detail is shown of a mesh created with second order tetrahedral elements. Second order elements map well to curvilinear geometry.

Shell elements

Besides solid elements, Solid Works Simulation also offers shell elements. While solid elements are created by meshing solid geometry, shell elements are created by meshing surfaces. Shell elements are primarily used for analyzing thin-walled structures. Since surface geometry does not carry information about thickness, the user must provide this information. Similar to solid elements, shell elements also come in draft and high quality with analogous consequences with respect to their ability to map to curvilinear geometry, as shown in figure 1-7 and figure 1-8. As demonstrated with solid elements, first order shell elements model the linear displacement field with constant strain and stress while second order shell elements model the second order (parabolic) displacement field and the first order strain and stress field.
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Figure 1-7: First order shell element

This shell element mesh was created with first order elements. Notice the imprecise mapping of the mesh to curvilinear geometry.
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Figure 1-8: Second order shell element

Shell element mesh created with second order elements, which map correctly to curvilinear geometry.

Certain classes of shapes can be modeled using either solid or shell elements, such as the plate shown in figure 1-9. The type of elements used depends then on the objective of the analysis. Often the nature of the geometry dictates what type of element should be used for meshing. For example, parts produced by casting are meshed with solid elements, while a sheet metal structure is best meshed with shell elements.
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Figure 1-9: Plate modeled with solid elements (left) and shell elements

The plate shown can be modeled with either solid elements (left) or shell elements (right). The actual choice depends on the particular requirements of analysis and sometimes on personal preferences

Figure 1-10, below, presents the basic library of elements in Solid Works Simulation.

Elements like a hexahedral solid, quadrilateral shell or other shapes are not available in Solid Works Simulation.

[image: image11.png]Triangular shell clement Tetrahedral solid element

6 Degrees of Freedom per node | 3 Degrees of Freedom per node

First order
element

Lincar displacement field
Constant stress field

Second order
element

Parabolic (sceond order)
displacement field

Linear siress field

Most comimonly
used clement




Figure 1-10: Solid Works Simulation element library

Four element types are available in the Solid Works Simulation element library. The vast majority of analyses use the second order tetrahedral element. Both solid and shell first order elements should be avoided.

The degrees of freedom (DOF) of a node in a finite element mesh define the ability of the node to perform translation or rotation. The number of degrees of freedom that a node possesses depends on the type of element that the node belongs to. In Solid Works Simulation, nodes of solid elements have three degrees of freedom, while nodes of shell elements have six degrees of freedom. This means that in order to describe transformation of a solid element from the components of nodal displacement, most often the x, y, z displacements. In the case of shell elements, we need to know not only the translational components of nodal displacements, but also the rotational displacement components.

What is calculated in FEA?

Each degree of freedom of every node in a finite element mesh constitutes an unknown. In structural analysis, where we look at deformations and stresses, nodal displacements are the primary unknowns. If solid elements are used, there are three displacement components (or 3 degrees of freedom) per node that must be calculated. With shell elements, six displacement components (or6 degrees of freedom) must be calculated. Everything else, such as strains and stresses, are calculated based on the nodal displacements. Consequently, rigid restraints applied to solid elements require only three degrees of freedom to be constrained. Rigid restraints applied to shell elements require that all six degrees of freedom be constrained. In a thermal analysis, which finds temperatures and heat flow, the primary unknowns are nodal temperatures. Since temperature is a scalar value (unlike the vector nature of displacements), then regardless of what type of element is used, there is only one unknown (temperature) to be found for each node. All other results available in the thermal analysis are calculated based on temperature results. The fact that there is only one unknown to be found for each node; rather than three or six, makes thermal analysis less computationally intensive than structural analysis.

How to interpret FEA results

Results of structural FEA are provided in the form of displacements and stresses. But how do we decide if a design "passes" or "fails" and what does it take for alarms to go off? What exactly constitutes a failure? 

To answer these questions, we need to establish some criteria to interpret FEA results, which may include maximum acceptable deformation, maximum stress, or lowest acceptable natural frequency. 

While displacement and frequency criteria are quite obvious and easy to establish, stress criteria are not. Let's assume that we need to conduct a stress analysis in order to ensure that stresses are within an acceptable range. To judge stress results, we need to understand the mechanism of potential failure, if a part breaks, what stress measure best describes that failure? Is it vonMises stress, maximum principal stress, shear stress, or something else? COSMOS Works can present stress results in any form we want. It is up to us to decide which stress measure to use for issuing a "pass" or "fail" verdict.

 Any textbook on the Mechanics of Materials provides information on various failure criteria. Interested readers can also refer to books. Here we will limit our discussion to outlining the differences between two commonly used stress measures: Von Mises stress and the principal stress.

Von Mises stress

Von Mises stress, also known as Huber stress, is a stress measure that accounts for all six stress components of a general 3-D state of stress (figure 1-11).
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Figure 1-11: General state of stress represented by three normal stresses: σx, σy, σz and six shear stresses τxy = τyx, τyz = τzy, τzx = τxz
Two components of shear stress and one component of normal stress act on each side of an elementary cube. Due to equilibrium requirements, the general 3-Dstate of stress is characterized by six stress components: σx, σy, σz and τxy = τyx, τyz = τzy, τzx = τxz
[image: image13.png]Von Mises stress o, can be expressed either by six stress components as

Oy = \/0A5~[(a\ ~0W +(Oy-0=) +(0:-09" ]34 (Tn’ + T +727)

or by three principal stresses (see the next paragraph) as:

0 =J0.5:[0,-03)" 10, -0y 105 -0 ]




Note that von Mises stress is a non-negative, scalar value. Von Mises stress is commonly used to present results because structural safety for many engineering materials showing elasto-plastic properties (for example, steel) can be evaluated using von Mises stress. The magnitude of von Mises stress can be compared to material yield or to ultimate strength to calculate the yield strength or the ultimate strength safety factor.

Principal stresses

By properly adjusting the angular orientation of the stress cube in figure 1-11, shear stresses disappear and the state of stress is represented only by three principal stresses: o:, o2, and 03, as shown in figure 1-12. In Solid Works simulation, principal stresses are denoted as σ1, σ2, and σ3.
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Figure 1-12: General state of stress represented by three principal stresses: σ1, σ2, σ3

Units of measurements

Internally, Solid Works simulation uses the International System of Units (SI).However, for the user's convenience, the unit manager allows data entry in three different systems of units: SI, Metric, and English. Results can be displayed using any of the three unit systems. Figure 1-13 summarizes the available systems of units.
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Figure 1-13: Unit systems available in Solid Works simulation

SI, Metric, and English systems of units can be interchanged when entering data or analyzing results in Solid Works simulation Experience indicates that units of mass density are often confused with units of specific gravity. The distinction between these two is quite clear in SI units: Mass density is expressed in [kg/m3], while specific gravity in [N/m3].However, in the English system, both specific mass and specific gravity are .expressed in [lb/in.3], where [lb] denotes either pound mass or pound force. As Solid Works simulation users, we are spared much confusion and trouble with systems of units. However, we may be asked to prepare data or interpret the results of other FEA software where we do not have the convenience of the unit manager. Therefore, we will make some general comments about the use of different systems of units in the preparation of input data for FEA models. We can use any consistent system of units for FEA models, but in practice, the choice of the system of units is dictated by what units are used in the CAD model. The system of units in CAD models is not always consistent; length can be expressed in [mm], while mass density can be expressed in [kg/m3].Contrary to CAD models, in FEA all units must be consistent. Inconsistencies are easy to overlook, especially when defining mass and mass density, and they can lead to very serious errors.

SI, Metric, and English systems of units can be interchanged when entering data or analyzing results in Solid Works simulation

Experience indicates that units of mass density are often confused with units of specific gravity. The distinction between these two is quite clear in SI units: Mass density is expressed in [kg/m3], while specific gravity in [N/m3].However, in the English system, both specific mass and specific gravity are .expressed in [lb/in.3], where [lb] denotes either pound mass or pound force. As Solid Works simulation users, we are spared much confusion and trouble with systems of units. However, we may be asked to prepare data or interpret the results of other FEA software where we do not have the convenience of the unit manager. Therefore, we will make some general comments about the use of different systems of units in the preparation of input data for FEA models. We can use any consistent system of units for FEA models, but in practice his choice of the system of units is dictated by what units are used in the CAD model. The system of units in CAD models is not always consistent; length can be expressed in [mm], while mass density can be expressed in [kg/m3].Contrary to CAD models, in FEA all units must be consistent. Inconsistencies are easy to overlook, especially when defining mass and mass density, and they can lead to very serious errors.

In the SI system, which is based on meters [m] for length, kilograms [kg] for mass and seconds [s] for time, all other units are easily derived from these basic units. In mechanical engineering, length is commonly expressed in millimeters [mm], force in Newton [N], and time in seconds [s]. All other units must then be derived from these basic units: [mm], [N], and [s].Consequently, the unit of mass is defined as a mass which, when subjected to a unit force equal to IN, will accelerate with a unit acceleration of 1 mm/s2.Therefore, the unit of mass in a system using [mm] for length and [N] for force, is equivalent to 1,000 kg or one metric ton. Consequently, mass density is expressed in metric tonne [tonne/mm3]. This is critically important to remember when defining material properties in FEA software without a unit manager. Notice in figure 1-14 that an erroneous definition of mass density in [kg/m3] rather than in [tonne/mm3] results in mass density being one trillion (1012) times higher (figure 1-14).

[image: image16.png]System SI [m], [N], [s]
Unit of mass kg
Unit of mass density kgm’
| Density for aluminum 2794 ke
System of units derived [mm], [N], [s]
from SI
Unit of mass tonne
Unit of mass density tonne/mm’
Density of aluminum 2.794% 10” tonne/mm’
English system (IPS) [in], [LB]. [s]
Unit of mass LB =slug/12
Unit of mass density slug/12/in.*
Density of aluminum 2.614x 10™ slug/1 2/in.*





Figure 1-14: Mass densities of aluminum in the three systems of units

Comparison of numerical values of mass densities of aluminum defined in this system of units with the system of units derived from SI, and with the English (IPS) system of units.

Ex. No: 1


Stress analysis of beams

(Simply supported, Cantilever & Fixed ends)
AIM:


To perform displacement and stress analysis for the given beams (Simply supported, Cantilever& Fixed ends) using solid works simulation and analytical expressions.

Problem Description:

(i)
A distributed load & Point load will be applied to a solid steel beam with a rectangular cross section as shown in the figure (1.1) below. The cross-section of the beam is 132mm x 264mm while the modulus of elasticity of the steel is 210GPa. Find reaction, deflection and stresses in the beam.

[image: image17]
(ii)
A distributed load & Point load will be applied to a solid steel beam with a rectangular cross section as shown in the figure (1.2) below. The cross-section of the beam is 150mm x 300mm while the modulus of elasticity of the steel is 210GPa. Find reaction, deflection and stresses in the beam.

[image: image18]
(iii)
A distributed load & Point load will be applied to a solid steel beam with a rectangular cross section as shown in the figure (1.3) below. The cross-section of the beam is 572mm x 1144mm while the modulus of elasticity of the steel is 210GPa. Find reaction, deflection and stresses in the beam.


[image: image19]
Problem (I) 

  Creation of solid model 

Solid part 1:

· Sketch module:


Open a new part file →select the right plane →select normal view→ draw rectangular shape →select smart dimensions modify the dimensions as 132 X 264 mm

· Feature Module:


Select the sketch1 → select extruded boss → extrude with a length 3000mm → ok.

Solid part 2:

· Sketch module:


Select the right end face →select normal view→ draw rectangular shape →select smart dimensions modify the dimensions as 132 X 264 mm

· Feature Module:


Select the sketch2 → select extruded boss → extrude with thickness 3000mm → unselect merge component → ok.

The model must be a solid object

Reference point:

· Sketch → point → Select the top surface → select normal view → locate a point →select smart dimensions modify the location of the point as 2000 mm from right end → ok.

· Select reference point → select sketch3 (point) & top surface → ok
Analysis the solid model 

Step by step procedure for the analysis.
Simulation Module:

             Verify that simulation mode is selected in the Add-lns list. To start Simulation, Once Solid Works Simulation has been added, Simulation shows in the main Solid Works tool menu. Select the simulation Manager tab.

· New Study: 

                 To define a new study, select New Study either from the Simulation menu or the Simulation Command Manager > When a study is defined, Solid Works Simulation creates a study window located below the Solid Works Feature Manager window and places several folders in it. It also adds a study tab that provides access to the window. 
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· Static Study: 

· To select static study in the study tab. Simulation automatically creates a study folder with the following sub folders: Static Study, Connections, Fixtures, Loads, Mesh and Report folder.   
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· Right click on the Static study - Treat the solid part 1 & 2 as a beam separately.
· Apply Materials:

To apply material to the Simulation model, right-click the solid part folder in  the simulation study→  select Apply/Edit Material from the pop-up menu → This action opens the Material → Select From library files in the Select material source area→  Select Alloy Steel.
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· Calculate the Joints:

  To calculate the joint→ Right-click the joints folder in Static study → edit → calculate → ok (after finding display of no. of joints model)
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· Apply Fixtures:

· To define the Fixture(1) at end A→ Right-click the Fixture folder in Static study → select fixed geometry as Fixture type → Select the left end joint where Fixture is to be applied → Select immovable geometry → ok. 
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· To define the Fixture (2) at end B → Right-click the Fixture folder in Static study → select fixed geometry as Fixture type → Select the right end joint→ Select reference geometry as fixture type → Select the top surface as reference plane to represent the direction of the force → Select the force direction which is normal to the selected reference plane → Enter valve 0 → In the graphic window note the symbols of the applied Fixture. 

· Apply loads:

              We now define the load by selecting Force from the pop-up menu.     
This action opens the Force window. The Force window displays the 
portion where point load & uniformly distributed load is applied 


UDL:

· Right click the load folder → Select forces → select the solid part1 → select load / m → select the top surface as reference plane to represent the direction of the force. This illustration also shows symbols of applied restraint and load→ select the force direction which is normal to the selected reference button in order to load the beam with 20,000 N/m of uniformly distributed load over the selected face → ok.

Point Load:

· Right click the load folder → Select forces → select the reference point → select the top surface as reference plane to represent the direction of the force → select the force direction which is normal to the selected reference button in order to load the beam with 20,000 N of point load on the selected point → ok.
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· Create the mesh:

We are now ready to mesh the model → Right-click the Mesh folder → create mesh

· Run the analysis:

   
Right-clicks the simulation mode → Select Run to start the solution. A successful or failed solution is reported and must be acknowledged before proceeding to analysis of results. When the solution completes successfully, Simulation creates a Results folder with result plots which are defined in Simulation Default Options.
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· Results:


With the solution completed simulation automatically creates Results folder with several new folders in the study Manager Window like Stress, Displacement, and Strain & Deformation. Each folder holds an automatically created plot with its respective type of results. The solution can be executed with different properties.

Select one of the following analyses you want to see:

· Stress distribution 

· Displacement distribution 
· Deformed shape 
[image: image27.png]PropertyManager [=E2]

i Displacement Plot 2
v X =
Display P

b et st v]

eformed Shape. a
@ Automatic

44905

O True scale
O User defined

»

Property v





Make sure that the above plots are defined in your configuration, if not, define them. Once the solution completes, you can add more plots to the Results folder. You can also create subfolders in the Results folder to group plots.


To display stress results, double-click on the Stress1 icon in the Results folder or right-click it and select Show from the pop-up menu.

Problem (ii) & (iii) 

Follow the same procedure with required changes.  

Result:


The analysis of the beam was carried out using the solidworks simulation and the software results were compared with theoretical or analytical results.

Ex. No: 2       Stress analysis of a Rectangular plate with circular holes 

Aim:


To perform displacement and stress analysis for the given rectangular plate with holes using solid works simulation and analytical expressions.

Problem description:


A steel plate with 3 holes 3mm, 5mm & 10 mm respectively is supported and loaded, as shown in figure. We assume that the support is rigid (this is also called built-in support or fixed support) and that the 20 KN tensile load is uniformly distributed on the end face, opposite to the supported face. The cross section is 15 mm x 25 mm. length is 100mm. Material (Alloy steel) 
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Creation of the solid model using solid works

Sketch module:


Sketch(1) > Open a new part file →select the front plane →select normal view→ draw rectangular shape →select smart dimensions modify the dimensions as 15 X 25 mm→ Draw three circles as 3mm, 5mm & 10 mm with 25mm distance.

Feature Module:


Feature (1) > Select the sketch (!) → Select extruded boss → extrude with thickness 100mm.

Sketch module:


Sketch (2) → select the front surface →select normal view → Draw three circles as 3mm, 5mm & 10 mm with 25mm distance.

Feature Module:


Feature (2) > Select the sketch (2) → select extruded cut → extrude with thickness 15mm → ok
Analysis of the solid model 

Simulation Module:

             Verify that simulation mode is selected in the Add-lens list. To start Simulation, Once Solid Works Simulation has been added, Simulation shows in the main Solid Works tool menu. Select the simulation Manager tab.
· New Study: 

                 To define a new study, select New Study either from the Simulation menu or the Simulation Command Manager > When a study is defined, Solid Works Simulation creates a study window located below the Solid Works Feature Manager window and places several folders in it. It also adds a study tab that provides access to the window. 

· Static Study: 

To select static study in the study tab. Simulation automatically creates a study folder with the following sub folders: Static Study, Connections, Fixtures, Loads, Mesh and Report folder.   

· Apply Materials:

To apply material to the Simulation model, right-click the part

folder in  simulation study and select Apply/Edit Material from the pop-up menu → This action opens the Material → Select From library files in the Select material source area→  Select Alloy Steel.

· Apply Fixtures:

           To define the Fixtures→ Right-click the Fixture folder in Static study → select fixed geometry as Fixture type → select the left end face → ok

· Apply loads:

              We now define the load by selecting Force from the pop-up menu. The Force window displays the selected face where tensile force is applied →Select use reference geometry → Select the right plane as reference plane to represent the direction of the force. → Select the force direction which is normal to the selected reference plane button in order to load the Model with 20,000 N of tensile force uniformly distributed over the end face. 

· Create the mesh:

               We are now ready to mesh the model → Right-click the Mesh folder → create mesh

· Run the analysis:

   
Right-clicking the simulation mode → Select Run to start the solution. A successful or failed solution is reported and must be acknowledged before proceeding to analysis of results. When the solution completes successfully, Simulation creates a Results folder with result plots which are defined in Simulation Default Options.
· Results:

With the solution completed simulation automatically creates Results folder with several new folders in the study Manager Window like Stress, Displacement, and Strain & Deformation. Each folder holds an automatically created plot with its respective type of results. 

· Stress1 showing in normal x direction

· Displacement1 showing resultant displacements


To display stress results, double-click on the Stress1 icon in the Results folder or right-click it and select Show from the pop-up menu.

Result:


The analysis of the rectangular plate was carried out using the solid works simulation and software results were compared with theoretical or analytical values.

Ex. No: 3         Stress analysis of a Rectangular L Bracket

Aim:


To perform displacement and stress analysis for the given rectangular L Bracket (Wall Bracket) using solid works simulation and analytical expressions.

Problem description:

An L-shaped bracket is supported and loaded as shown in figure 3-1. We wish to find the Displacements and stresses caused by a 5,000 N which is 60° inclined. In particular, we are interested in stresses in the corner where the 5 mm round edge (fillet) is located. Material Grey Cast Iron.
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Creation of  the solid model 

Sketch module:


Open a new part file →select the front plane →select normal view→ draw the required shape →select smart dimensions→ modify the dimensions →select fillet mode →enter radius 5mm→select the specified edges→ok.

Feature Module:


Select the sketch → select extruded boss → select midplane option → extrude with thickness 17.5mm.

Sketch Point:

· Select the front plane → normal view → draw a line (sketch 2) from the centre of the hole which is 60º inclined to the vertical.

· Select the front plane → locate the intersection point of 60º inclined line & sketch 3 →ok.

Reference point:

· Select reference point geometry → select sketch 3 point & inner surface of the hole → ok.

Analysis of the solid model 
Simulation Module:

             Verify that simulation mode is selected in the Add-lns list. To start Simulation, Once Solid Works Simulation has been added, Simulation shows in the main Solid Works tool menu. Select the simulation Manager tab.
· New Study: 

                 To define a new study, select New Study either from the Simulation menu or the Simulation Command Manager > When a study is defined, Solid Works Simulation creates a study window located below the Solid Works Feature Manager window and places several folders in it. It also adds a study tab that provides access to the window. 

· Static Study: 

To select static study in the study tab. Simulation automatically creates a study folder with the following sub folders: Static Study, Connections, Fixtures, Loads, Mesh and Report folder.   

· Apply Materials:

To apply material to the Simulation model, right-click the part

folder in  simulation study and select Apply/Edit Material from the pop-up menu → This action opens the Material → Select From library files in the Select material source area→  Select Grey Cast Iron.

· Apply Fixtures:

           To define the Fixtures→ Right-click the Fixture folder in Static study In Fixtures→ select fixed geometry as Fixture type → select the model face (left end face) where Fixture is to be applied→ ok.

· Apply loads:

              Right-click the Force folder → Select force →  Select the reference point → select the reference plane to represent the direction of the force in order to load the Model with 5000 N of which is 60º inclined.. This illustration also shows symbols of applied restraint and load  

· Create the mesh:

               We are now ready to mesh the model → Right-click the Mesh folder → create mesh

· Run the analysis:

   
Right-clicking the simulation mode → Select Run to start the solution. When the solution completes successfully, Simulation creates a Results folder with result plots which are defined in Simulation Default Options.
· Results:


With the solution completed simulation automatically creates Results folder with several new folders in the study Manager Window like Stress, Displacement, and Strain & Deformation. Each folder holds an automatically created plot with its respective type of results. The solution can be executed with different properties.

· Stress1 showing von Misses stresses
· Displacement1 showing resultant displacements

Once the solution completes, you can add more plots to the Results folder. You can also create subfolders in the Results folder to group plots.


To display stress results, double-click on the Stress1 icon in the Results folder or right-click it and select Show from the pop-up menu.

Result:


The analysis of the L - Bracket was carried out using the solidworks simulation and the software results were compared with analytical values.

Ex.Mo.4
Stress analysis of an axi-symmetric component

Aim:


To perform stress analysis for the given axi-symmetric component.
Problem description:

Creation of  the solid model 

Sketch module:


Open a new part file →select the top plane →select normal view→ draw the rectangular shape →select smart dimensions→ modify the dimensions 1000mm x 15mm →ok.


Select sketch → draw centre axis → ok.
Feature Module:


Select the sketch → select revolve → select the centre axis→ revolution angle 90º.
Surface Module:

Select surface → mid surface →select the two outer faces →ok.

Right click the surface model → edit definition  → enter thickness 15mm → ok.
Analysis of the solid model 
Simulation Module:

· New Study: 

                 To define a new study → select New Study →static →ok.
· Static Study: 

To select static study in the study tab. Simulation automatically creates a study folder with the following sub folders: Static Study, Connections, Fixtures, Loads, Mesh and Report folder.   

· Apply Materials:

To apply material to the Simulation model →   right-click the part

folder in  simulation study and select Apply/Edit Material → Alloy steel → ok.
· Apply Fixtures:

           To define the Fixtures→ Right-click the Fixture folder in Static study In Fixtures→ select Advanced geometry → select symmetry → select the end faces (left & right end face) where Fixture is to be applied → ok.

· Apply loads:

              Right-click the Force folder → Select Pressure →  Select the inner surface of the sector →Enter pressure 1.5Mpa → ok.
· Create the mesh:

               Right-click the Mesh folder → create mesh → select Automatic transition →ok.
· Run the analysis:

   
Select Run to start the solution
· Results:


The solution can be executed with different properties.

· stresses
· displacements
· strains
Result:


The analysis of the axi-symmetric component was carried out using the solidworks simulation and the software results were compared with analytical values.

Ex. No: 5
Mode frequency analysis of a 2 D component

Ex. No: 6
Mode frequency analysis of beams (Cantilever, Simply              

                  
Supported, Fixed ends)

Ex. No: 7
Harmonic analysis of a 2D component

Ex. No: 8
Thermal stress analysis of a 2D component 

 

Ex. No: 9
Conductive heat transfer analysis of a 2D component

AIM:

Ex. No: 10        Convective heat transfer analysis of a 2D component

MATLAB INTRODUCTION:

Overview of the MATLAB® Environment

The MATLAB® high-performance language for technical computing integrates computation, visualization, and programming in an easy-to-use environment where problems and solutions are expressed in familiar mathematical

notation. Typical uses include

• Math and computation

• Algorithm development

• Data acquisition

• Modeling, simulation, and prototyping

• Data analysis, exploration, and visualization

• Scientific and engineering graphics

• Application development,

 Including graphical user interface building MATLAB is an interactive system whose basic data element is an array that does not require dimensioning. It allows you to solve many technical computing problems, especially those with matrix and vector formulations, in a fraction of the time it would take to write a program in a scalar noninteractive language such as C or FORTRAN.

The name MATLAB stands for matrix laboratory. MATLAB was originally written to provide easy access to matrix software developed by the LINPACK and EISPACK projects. Today, MATLAB engines incorporate the LAPACK and BLAS libraries, embedding the state of the art in software for matrix computation.


[image: image30.emf]
SIMULINK INTRODUCTION:

Simulink is a graphical extension to MATLAB for modeling and simulation of systems. In Simulink, systems are drawn on screen as block diagrams. Many elements of block diagrams are available, such as transfer functions, summing junctions, etc., as well as virtual input and output devices such as function generators and oscilloscopes. Simulink is integrated with MATLAB and data can be easily transferred between the programs. In these tutorials, we will apply Simulink to the examples from the MATLAB tutorials to model the systems, build controllers, and simulate the systems. Simulink is supported on Unix, Macintosh, and Windows environments; and is included in the student version of MATLAB for personal computers. 

The idea behind these tutorials is that you can view them in one window while running Simulink in another window. System model files can be downloaded from the tutorials and opened in Simulink. You will modify and extend these system while learning to use Simulink for system modeling, control, and simulation. Do not confuse the windows, icons, and menus in the tutorials for your actual Simulink windows. Most images in these tutorials are not live - they simply display what you should see in your own Simulink windows. All Simulink operations should be done in your Simulink windows.

1. Starting Simulink 

2. Model Files 

3. Basic Elements 

4. Running Simulations 

5. Building Systems 

Starting Simulink

Simulink is started from the MATLAB command prompt by entering the following command: 

>> Simulink

Alternatively, you can hit the Simulink button at the top of the MATLAB window as shown below: 
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When it starts, Simulink brings up the Simulink Library browser. 
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Open the modeling window with New then Model from the File menu on the Simulink Library Browser as shown above.

This will bring up a new untitiled modeling window shown below.
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Model Files

In Simulink, a model is a collection of blocks which, in general, represents a system. In addition to drawing a model into a blank model window, previously saved model files can be loaded either from the File menu or from the MATLAB command prompt.

You can open saved files in Simulink by entering the following command in the MATLAB command window. (Alternatively, you can load a file using the Open option in the File menu in Simulink, or by hitting Ctrl+O in Simulink.)

  >> filename

The following is an example model window.
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A new model can be created by selecting New from the File menu in any Simulink window (or by hitting Ctrl+N).

Basic Elements

There are two major classes of items in Simulink: blocks and lines. Blocks are used to generate, modify, combine, output, and display signals. Lines are used to transfer signals from one block to another. 

Blocks
There are several general classes of blocks:

  Continuous 

  Discontinuous 

  Discrete 

  Look-Up Tables 

  Math Operations 

  Model Verification 

  Model-Wide Utilities 

  Ports & Subsystems 

  Signal Attributes 

  Signal Routing 

  Sinks: Used to output or display signals 

  Sources: Used to generate various signals 

  User-Defined Functions 

  Discrete: Linear, discrete-time system elements (transfer functions, state-space models, etc.) 

  Linear: Linear, continuous-time system elements and connections (summing junctions, gains, etc.) 

  Nonlinear: Nonlinear operators (arbitrary functions, saturation, delay, etc.) 

  Connections: Multiplex, Demultiplex, System Macros, etc. 

Blocks have zero to several input terminals and zero to several output terminals. Unused input terminals are indicated by a small open triangle. Unused output terminals are indicated by a small triangular point. The block shown below has an unused input terminal on the left and an unused output terminal on the right.
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Lines
Lines transmit signals in the direction indicated by the arrow. Lines must always transmit signals from the output terminal of one block to the input terminal of another block. One exception to this is a line can tap off of another line, splitting the signal to each of two destination blocks, as shown below.
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Lines can never inject a signal into another line; lines must be combined through the use of a block such as a summing junction.

A signal can be either a scalar signal or a vector signal. For Single-Input, Single-Output systems, scalar signals are generally used. For Multi-Input, Multi-Output systems, vector signals are often used, consisting of two or more scalar signals. The lines used to transmit scalar and vector signals are identical. The type of signal carried by a line is determined by the blocks on either end of the line.

Simple Example
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The simple model (from the model files section) consists of three blocks: Step, Transfer Fcn, and Scope. The Step is a source block from which a step input signal originates. This signal is transferred through the line in the direction indicated by the arrow to the Transfer Function linear block. The Transfer Function modifies its input signal and outputs a new signal on a line to the Scope. The Scope is a sink block used to display a signal much like an oscilloscope.

There are many more types of blocks available in Simulink, some of which will be discussed later. Right now, we will examine just the three we have used in the simple model.

Modifying Blocks
A block can be modified by double-clicking on it. For example, if you double-click on the "Transfer Fcn" block in the simple model, you will see the following dialog box.
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This dialog box contains fields for the numerator and the denominator of the block's transfer function. By entering a vector containing the coefficients of the desired numerator or denominator polynomial, the desired transfer function can be entered. For example, to change the denominator to s^2+2s+1, enter the following into the denominator field:


[1 2 1]

and hit the close button, the model window will change to the following:
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which reflects the change in the denominator of the transfer function.

The "step" block can also be double-clicked, bringing up the following dialog box.
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The default parameters in this dialog box generate a step function occurring at time=1 sec, from an initial level of zero to a level of 1. (in other words, a unit step at t=1). Each of these parameters can be changed. Close this dialog before continuing.

The most complicated of these three blocks is the "Scope" block. Double clicking on this brings up a blank oscilloscope screen.
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When a simulation is performed, the signal which feeds into the scope will be displayed in this window. Detailed operation of the scope will not be covered in this tutorial. The only function we will use is the autoscale button, which appears as a pair of binoculars in the upper portion of the window. 

Running Simulations

To run a simulation, we will work with the following model file:

simple2.mdl

Download and open this file in Simulink following the previous instructions for this file. You should see the following model window.
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Before running a simulation of this system, first open the scope window by double-clicking on the scope block. Then, to start the simulation, either select Start from the Simulation menu (as shown below) or hit Ctrl-T in the model window.
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The simulation should run very quickly and the scope window will appear as shown below. If it doesn't, just double click on the block labeled "scope."
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Note that the simulation output (shown in yellow) is at a very low level relative to the axes of the scope. To fix this, hit the autoscale button (binoculars), which will rescale the axes as shown below.
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Note that the step response does not begin until t=1. This can be changed by double-clicking on the "step" block. Now, we will change the parameters of the system and simulate the system again. Double-click on the "Transfer Fcn" block in the model window and change the denominator to

  [1 20 400]

Re-run the simulation (hit Ctrl-T) and you should see what appears as a flat line in the scope window. Hit the autoscale button, and you should see the following in the scope window.
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Notice that the autoscale button only changes the vertical axis. Since the new transfer function has a very fast response, it compressed into a very narrow part of the scope window. This is not really a problem with the scope, but with the simulation itself. Simulink simulated the system for a full ten seconds even though the system had reached steady state shortly after one second.

To correct this, you need to change the parameters of the simulation itself. In the model window, select Parameters from the Simulation menu. You will see the following dialog box.
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There are many simulation parameter options; we will only be concerned with the start and stop times, which tell Simulink over what time period to perform the simulation. Change Start time from 0.0 to 0.8 (since the step doesn't occur until t=1.0. Change Stop time from 10.0 to 2.0, which should be only shortly after the system settles. Close the dialog box and rerun the simulation. After hitting the autoscale button, the scope window should provide a much better display of the step response as shown below.
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Building Systems

In this section, you will learn how to build systems in Simulink using the building blocks in Simulink's Block Libraries. You will build the following system.

[image: image49.png]buildex e[-[ofx]

Fle Edt View Sinustion Fomat Tooks Help

DeE& fB2Raa(r (Sl hE T ®

] = b R=
Sum Gain Pl Controller Plant Soope

Ready ooz [odst5





First you will gather all the necessary blocks from the block libraries. Then you will modify the blocks so they correspond to the blocks in the desired model. Finally, you will connect the blocks with lines to form the complete system. After this, you will simulate the complete system to verify that it works.

Gathering Blocks
Follow the steps below to collect the necessary blocks: 

  Create a new model (New from the File menu or Ctrl-N). You will get a blank model window. 
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  Click on the Library Browser button [image: image51.png]


to open the Simulink Library Browser. Click on the Sources option under the expanded Simulink title to reveal possible sources for the model. 
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  Drag the Step block from the sources window into the left side of your model window. 
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  From the Simulink Library Browser, drag the Sum and Gain from "Math Operations" option found under the Simulink title. 
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  Switch to the "Continuous" option and drag two instances of the Transfer Fcn (drag it two times) into your model window arranged approximately as shown below. The exact alignment is not important since it can be changed later. Just try to get the correct relative positions. Notice that the second Transfer Function block has a 1 after its name. Since no two blocks may have the same name, Simulink automatically appends numbers following the names of blocks to differentiate between them. 
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  Click on the "Sinks" option then drag over the "Scope" icon 

[image: image56.png]untitled2 He[-[ofx]

Fle Edt View Sinustion Fomat Took Help

DEE& 2R Q) |cSy hE T ®

T

o > i} =

o Transtar Fen vy

TransterFont

Em)

Ready ooz [odst5





Modify Blocks
Follow these steps to properly modify the blocks in your model. 

  Double-click your Sum block. Since you will want the second input to be subtracted, enter +- into the list of signs field. Close the dialog box. 

  Double-click your Gain block. Change the gain to 2.5 and close the dialog box. 

  Double-click the leftmost Transfer Function block. Change the numerator to [1 2] and the denominator to [1 0]. Close the dialog box. 

  Double-click the rightmost Transfer Function block. Leave the numerator [1], but change the denominator to [1 2 4]. Close the dialog box. Your model should appear as: 
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  Change the name of the first Transfer Function block by clicking on the words "Transfer Fcn". A box and an editing cursor will appear on the block's name as shown below. Use the keyboard (the mouse is also useful) to delete the existing name and type in the new name, "PI Controller". Click anywhere outside the name box to finish editing. 
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  Similarly, change the name of the second Transfer Function block from "Transfer Fcn1" to "Plant". Now, all the blocks are entered properly. Your model should appear as: 
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Connecting Blocks with Lines
Now that the blocks are properly laid out, you will now connect them together. Follow these steps. 

  Drag the mouse from the output terminal of the Step block to the upper (positive) input of the Sum block. Let go of the mouse button only when the mouse is right on the input terminal. Do not worry about the path you follow while dragging, the line will route itself. You should see the following. 
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The resulting line should have a filled arrowhead. If the arrowhead is open, as shown below, it means it is not connected to anything.
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You can continue the partial line you just drew by treating the open arrowhead as an output terminal and drawing just as before. Alternatively, if you want to redraw the line, or if the line connected to the wrong terminal, you should delete the line and redraw it. To delete a line (or any other object), simply click on it to select it, and hit the delete key. 

  Draw a line connecting the Sum block output to the Gain input. Also draw a line from the Gain to the PI Controller, a line from the PI Controller to the Plant, and a line from the Plant to the Scope. You should now have the following. 
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  The line remaining to be drawn is the feedback signal connecting the output of the Plant to the negative input of the Sum block. This line is different in two ways. First, since this line loops around and does not simply follow the shortest (right-angled) route so it needs to be drawn in several stages. Second, there is no output terminal to start from, so the line has to tap off of an existing line. 

To tap off the output line, hold the Ctrl key while dragging the mouse from the point on the existing line where you want to tap off. In this case, start just to the right of the Plant. Drag until you get to the lower left corner of the desired feedback signal line as shown below.
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Now, the open arrowhead of this partial line can be treated as an output terminal. Draw a line from it to the negative terminal of the Sum block in the usual manner.
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  Now, you will align the blocks with each other for a neater appearance. Once connected, the actual positions of the blocks does not matter, but it is easier to read if they are aligned. To move each block, drag it with the mouse. The lines will stay connected and re-route themselves. The middles and corners of lines can also be dragged to different locations. Starting at the left, drag each block so that the lines connecting them are purely horizontal. Also, adjust the spacing between blocks to leave room for signal labels. You should have something like: 
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  Finally, you will place labels in your model to identify the signals. To place a label anywhere in your model, double click at the point you want the label to be. Start by double clicking above the line leading from the Step block. You will get a blank text box with an editing cursor as shown below 
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Type an r in this box, labeling the reference signal and click outside it to end editing.

  Label the error (e) signal, the control (u) signal, and the output (y) signal in the same manner. Your final model should appear as: 
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  To save your model, select Save As in the File menu and type in any desired model name. 

Simulation
Now that the model is complete, you can simulate the model. Select Start from the Simulation menu to run the simulation. Double-click on the Scope block to view its output. Hit the autoscale button (binoculars) and you should see the following.
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Taking Variables from MATLAB
In some cases, parameters, such as gain, may be calculated in MATLAB to be used in a Simulink model. If this is the case, it is not necessary to enter the result of the MATLAB calculation directly into Simulink. For example, suppose we calculated the gain in MATLAB in the variable K. Emulate this by entering the following command at the MATLAB command prompt.

  K=2.5

This variable can now be used in the Simulink Gain block. In your Simulink model, double-click on the Gain block and enter the following in the Gain field.

K

[image: image69.png]Gan

Element-vise gain [y = K. ) o i gain [y = K'u oy = K]

——

e

®

Mulileation: [Elerentwisel™) 7]
=

Show addiional parameters

K Concel | Hep | |





Close this dialog box. Notice now that the Gain block in the Simulink model shows the variable K rather than a number.
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Now, you can re-run the simulation and view the output on the Scope. The result should be the same as before.
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Now, if any calculations are done in MATLAB to change any of the variables used in the Simulink model, the simulation will use the new values the next time it is run. To try this, in MATLAB, change the gain, K, by entering the following at the command prompt.

K=5

Start the Simulink simulation again, bring up the Scope window, and hit the autoscale button. You will see the following output which reflects the new, higher gain.
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Besides variables, signals and even entire systems can be exchanged between MATLAB and Simulink

Simulation using MAT LAB:

ExNo : 15
Simulation of Spring – Mass System

Writing Matlab Functions: Damped spring system
In this example, we will create a Simulink model for a mass attached to a spring with a linear damping force.
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A mass on a spring with a velocity-dependant damping force and a time-dependant force acting upon it will behave according to the following equation:
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The model will be formed around this equation. In this equation, 'm' is the equivalent mass of the system; 'c' is the damping constant; and 'k' is the constant for the stiffness of the spring. First we want to rearrange the above equation so that it is in terms of acceleration; then we will integrate to get the expressions for velocity and position. Rearranging the equation to accomplish this, we get:
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To build the model, we start with a 'step' block and a 'gain' block. The gain block represents the mass, which we will be equal to 5. We also know that we will need to integrate twice, that we will need to add these equations together, and that there are two more constants to consider. The damping constant 'c' will act on the velocity, that is, after the first integration, and the constant 'k' will act on the position, or after the second integration. Let c = 0.35 and let k = 0.5. Laying all these block out to get an idea of how to put them together, we get:
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By looking at the equation in terms of acceleration, it is clear that the damping term and spring term are summed negatively, while the mass term is still positive. To add places and change signs of terms being summed, double-click on the sum function block and edit the list of signs:
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Once we have added places and corrected the signs for the sum block, we need only connect the lines to their appropriate places. To be able to see what is happening with this spring system, we add a 'scope' block and add it as follows:
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The values of 'm', 'c' and 'k' can be altered to test cases of under-damping, critical-damping and over-damping. To accurately use the scope, right-click the graph and select "Autoscale".

The mdl-file can now be saved. The following is a sample output when the model is run for 30 iterations.
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ExNO:16 Simulation of Air-conditioning of a house

Air  Conditioning of a House: Simulation of Room Heater

                     This  illustrates how we can use Simulink to create the Air Conditioning  of a house - Room Heater. This system depends on  the outdoor environment,  the thermal characteristics of the house, and the house heating system.  The air_condition1.m file initializes data in the model workspace. To make changes, we can edit the model workspace directly or edit the m-file  and re-load the model workspace. 

Opening the Model

         In the MATLAB window, load the model by executing the following code (select the code and press F9 to evaluate selection).

mdl=’air_condition01’;

open_system(mdl);

 The House Heating Model

 Model Initialization

         When the model is opened, it loads the information about the house from the air_condition1.m file.  The M-file does the following:            

               Defines the house geometry (size, number of windows)

               Specifies the thermal properties of house materials

               Calculates the thermal resistance of the house

               Provides the heater characteristics (temperature of the hot air, flow-rate)

               Defines the cost of electricity (Rs.4.00/kWhr)

               Specifies the initial room temperature (10 deg. Celsius = 50 deg. Fahrenheit)

               Note: Time is given in units of hours. Certain quantities, like air flow-rate, are expressed per hour (not per second).

         Model Components

         Set Point

         "Set Point" is a constant block. It specifies the temperature that must be maintained indoors. It is set at 86 degrees Fahrenheit which is equal to 30 degrees Centigrade.

            By default. Temperatures are given in Fahrenheit, but then are converted to Celsius to perform the calculations.

Thermostat

         "Thermostat" is a subsystem that contains a Relay block. The thermostat allows fluctuations of 5 degrees Fahrenheit above or below the desired room temperature. If air temperature drops below 81 degrees Fahrenheit, the thermostat turns on the heater.

            We can see the Thermostat subsystem by the following command in MATLAB Command window.

         open_system([mdl,'/Thermostat']);

         Heater

         "Heater" is a subsystem that has a constant air flow rate, "Mdot", which is specified in the air_condition.m M-file. The thermostat signal turns the heater on or off. When the heater is on, it blows hot air at temperature THeater

            (50 degrees Celsius = 122 degrees Fahrenheit by default) at a constant flow rate of Mdot (1kg/sec = 3600kg/hr by default).

            The heat flow into the room is expressed by the Equation 1.         

         Equation 1:    (dQ/dt) = (T heater – Troom)*Mdot*c

where c  is the heat capacity of air at constant pressure.

         We can see the Heater subsystem by the following command in MATLAB Command window.

 open_system([mdl,'/Heater']);

         Cost Calculator

         "Cost Calculator" is a Gain block. "Cost Calculator" integrates the heat flow over time and multiplies it by the energy cost.

             The cost of heating is plotted in the "PlotResults" scope.

           House

         "House" is a subsystem that calculates room temperature variations. It takes into consideration the heat flow from the heater  and heat losses to the environment. Heat losses and the temperature time derivative are expressed by Equation 2.

          Equation 2

(dQ/dt)losses  =(Troom – Tout) / Req  where Req is the equivalent thermal resistance of the house.

       We can see the House subsystem by the following command in MATLAB Command window. 

       open_system([mdl,'/House']);

        Modeling the Environment

         We model the environment as a heat sink with infinite heat capacity and time varying temperature Tout.  The constant block "Avg Outdoor Temp" specifies the average air temperature outdoors. The "Daily Temp Variation" Sine Wave block generates daily temperature fluctuations of outdoor temperature. We can vary these parameters and see how they affect the heating costs.

        Running the Simulation and Visualizing the Results

        We can run the simulation and visualize the results. 

        Open the "PlotResults" scope to visualize the results. The heat cost and indoor versus outdoor temperatures  are plotted on the scope. The temperature outdoor varies sinusoidally, whereas the indoors temperature is maintained within 5 degrees Fahrenheit of "Set Point". Time axis is labeled in hours.

         evalc('sim(mdl)');

open_system([mdl '/PlotResults']),

Remarks

         This particular model is designed to calculate the heating costs only. If the temperature of the outside air is higher than the room temperature, the room temperature will exceed the desired "Set Point”.

ExNO: 17 CAM and FOLLOWER SYSTEM

A cam and follower system is system/mechanism that uses a cam and follower to create a specific motion.  The cam is in most cases merely a flat piece of metal that has had an unusual shape or profile machined onto it.  This cam is attached to a shaft which enables it to be turned by applying a turning action to the shaft.  As the cam rotates it is the profile or shape of the cam that causes the follower to move in a particular way.  The movement of the follower is then transmitted to another mechanism or another part of the mechanism. 

	[image: image80.png]


  


 Examining the diagram shown above we can see that as some external turning force is applied to the shaft  (for example: by  motor or by hand) the cam rotates with it. The follower is free to move in the Y plane but is unable to move in the other two so as the lobe of the cam passes the edge of the follower it causes the follower to move up.  Then some external downward force (usually a spring and gravity) pushes the follower down making it keep contact with the cam.  This external force is needed to keep the follower in contact with the cam profile. 

 Displacement Diagrams: 

Displacement diagrams are merely a plot of two different displacements (distances).  These two dispalcements are: 

1. the distance travelled up or down by the follower and 

2. the angular displacement (distance) rotated by the cam 
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	In the diagram shown opposite we can see the two different displacements represented by the two different arrows.  The green arrow representing the displacement of the follower i.e. the distance travelled up or down by the follower.  The mustard arrow (curved arrow) shows the angular displacement travelled by the cam.  


  Note: Angular displacement is the angle through which the cam has rotated. 

If we examine the diagram shown below we can see the relationship between a displacement diagram and the actual profile of the cam.  Note only half of the displacement diagram is drawn because the second half of the diagram is the same as the first.  The diagram is correct from a theoretical point of view but would have to changed slightly if the cam was to be actually made and used.  We will consider this a little more in the the following section - Uniform Velocity.
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Uniform Velocity:  

Uniform Velocity means travelling at a constant speed in a fixed direction and as long as the speed or direction don't change then its uniform velocity. In relation to cam and follower systems, uniform velocity refers to the motion of the follower. 

Now let's consider a typical displacement diagram which is merely a plot of two different displacements (distances).  These two displacements are: 

1. the distance travelled up or down by the follower and 

2. the angular displacement (distance) of the cam 

Let us consider the case of a cam imparting a uniform velocity on a follower over a displacement of 30mm for the first half of its cycle.  

We shall take the cycle in steps.  Firstly if the cam has to impart a displacement of 30mm on follower over half its cycle then it must impart a displacement of 30mm÷180º for every 1º turned by the cam i.e. it must move the follower 0.167mm per degree turn.   This distance is to much to small to draw on a displacement diagram so we will consider the displacement of the follower at the start, at the end of the half cycle, the end of the full cycle and at certain other intervals (these intervals or the

length of these intervals will be decided on later).

  

	 
	Angle the cam has rotated through  
	Distance moved by the follower  

	Start of the Cycle  
	0º  
	0mm  

	End of first Half of the Cycle  
	180º  
	30mm  

	End of the Full Cycle  
	360º  
	0mm  


 We shall consider this in terms of a displacement diagram: 

First we will plot the graph. Before doing this we must first consider the increments that we will use. We will use millimeters for the follower displacement increments and because 1º is too small we will use increments of 30º for the angular displacement.

Once this is done then we can draw the displacement diagram as shown below.  Note a straight line from the displacement of the follower at the start of the motion to the displacement of the follower at the end of the motion represents uniform velocity. 

Displacement Diagram for Uniform Velocity
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 Simple Harmonic Motion:

For this type of motion the follower displacement does not change at a constant rate.  In other words the follower doesn't travel at constant speed.  The best way to understand this non-uniform motion is to imagine a simple pendulum swinging. 

Uniform Acceleration and Retardation:

This motion is used where the follower is required to rise or fall with uniform acceleration, that is its velocity is changing at a constant rate.

To conclude this:

A cam can impart three types of motion on its follower:

	Uniform velocity
	Simple harmonic motion
	Uniform acceleration and retardation


Each of these motions can be represented by a displacement diagram.
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Poisson's raia 028 NA  |Constant
Shear modulus 79010 N/m*2  Constant
Mass densiy 7700 kg/m'3 | Constant
Tensie stength 723825600 N/m*2  Constant
Compressive stiength N/m2 | Bonstant
Vild siength 620422000 N/m*2  Constant
Thermal expansion cosfficient 1,305 /Kelin (Constant
Themal canductivty 50 WimK) Constant
Specilc heat 450 JkaK) Constant
Material damping rati NA_|Constant
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